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About NexSens Technology, Inc. 
NexSens Technology, Inc. was started in the 1990s with a mission to advance the capabilities 

and simplify the development of environmental monitoring systems.  Our main focus is on the 

creation of easy-to-use computer software and powerful communications technology to provide 

advanced remote data acquisition and data logging systems. 

iChart is an easy-to-learn, easy-to-use Windows-based software program designed to interface 

with the industry’s most popular environmental monitoring sensors and systems. A large multi-

vendor instrument library makes setup quick and easy.  iChart automates much of the tedious 

programming, data collection and manual data processing common with other environmental 

data collection systems. 

The NexSens iSIC (Intelligent Sensor Interface and Control) is a state-of-the-art line of data 

loggers that simplify the collection of real-time data from environmental sensors and monitoring 

instruments.  The iSIC data logger supports multi-vendor sensor connections and is designed for 

environmental data monitoring with NexSens communication equipment and software.  

Remote data acquisition systems have been developed specifically for unattended monitoring 

applications.  NexSens telemetry systems provide real-time access and 2-way communication to 

remote environmental monitoring systems via direct-connect, landline phone, radio, and cellular 

telemetry. 

About iChart Software 

NexSens iChart software is a data collection and analysis tool for environmental monitoring 

instruments.  It provides both a direct interface to RS232 smart sensors (ie. multi-parameter 

sondes) and an interface to the NexSens iSIC data logger.   

iChart is a user-friendly software package that eliminates the complicated programming required 

to operate traditional data loggers and sensors.  Common sampling options such as log intervals, 

interrogation schedules, and sensor parameters are setup through easy to navigate dialog boxes 

and graphical menus.  iChart will automatically retrieve data from sensors directly connected to a 

PC, iSIC data logger, or NexSens telemetry system.  All data and sensor configuration settings 

are stored in a single iChart database. 

iChart includes a unique historical report creation tool that can generate customized reports with 

data from all sensors in an iChart database.  While creating a report, users can include specific 

information about the monitoring site, location, sensors, and project along with the recorded 

measurements from instruments.  After creation, reports can be converted to PDF, exported to 

Microsoft Excel, sent to colleagues via e-mail, uploaded to a web server, and more. 

iChart includes web data posting capabilities that provide access to sensor data over the 

Internet.  Users typically access their database through NexSens’ data hosting service 

www.WQData.com, but the option is also available to post the database to a personal web 

server.  WQData.com is very simple to use and iChart can be configured to upload data to it in 

minutes.  The user interface at WQData.com can display data in graphs and tables, and convert 

it to CSV format for download to a local PC. 
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How to Use This Manual 

This manual is designed to provide you with detailed instructions for interfacing specific sensors 

to the NexSens iSIC data logger.  

Important: Before attempting to interface a sensor with a NexSens data logging system, it is 

important that you have thoroughly read the operation manual(s) provided with your NexSens 

system and environmental monitoring sensor(s). 

This manual provides you with all the information needed to interface your sensor with the iSIC 

data logger.  For advanced system and sensor reference material: 

� Review the material in the iSIC operations manual: 

o http://www.nexsens.com/support/manuals.htm  

� Review the sensor manufacturer’s operations manual. This information should have been 

provided with the purchase of the sensor. This material can also typically be found at the 

instrument manufacturer’s website. 

� If you are still having difficulty, email your technical support question to:  

support@nexsens.com 

System Requirements 

iChart requires the following minimum system configuration: 

 

• Pentium class PC 

• 64 MB RAM 

• 100 MB hard drive space 

• 2MB video card 

• CD-ROM drive for software installation 

• Windows 95, 98, ME, NT4 (SP3 or higher), 2000 (SP1 or higher), XP 

 

For better performance and reliability, twice the minimum system configuration and WinNT4 

(or Win2000) are recommended.  If you are communicating with a NexSens 2100 Field 

modem, we recommend that you use an external modem with a Rockwell (Conexant) 

chipset.  If you are communicating with a NexSens 3100-iSIC Cellular modem, we 

recommend that you use a PC with access to a broadband Internet connection (ie. cable, 

DSL, T1). 
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Software Installation 

iChart is distributed on CD-ROM.  The setup program starts automatically when the CD is 

inserted.  If not, you can manually start the setup process by following the steps below.  We 

suggest that you accept the default options presented by the iChart setup program. 

 

Double click My Computer.  

Double click the CD-ROM drive to open iChart CD.  

Double click Setup.exe or Setup icon to start the installation program.  

 

During the installation, you will be asked to register iChart software.  You can either print the 

registration form and mail or fax it to NexSens or connect to the Internet and register online.  By 

registering within 30 days of purchasing iChart, you are eligible for 2 years of free software 

updates. 

 

After installation is complete, you can run iChart from the start menu Program|NexSens| 

iChart.  For your convenience a shortcut to iChart is also placed on your desktop. 
 

Important Notice 

Managing your environmental data and information is a formidable task.  iChart simplifies this 

effort and organizes your important data.  Be sure to backup your database and other important 

files on a regular basis.  To help you with this, iChart has automatic backup and remind-me-to 

backup features. 

See Backup and Restore for details. 

Uninstalling Software 

To uninstall iChart, click Settings in the Start Menu. Select Control Panel and then Add / 

Remove Programs and select “iChart5”. Follow the instructions to remove iChart and all 

associated files.  
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1 What is iChart? 
 
iChart is an advanced and highly graphical user interface for a large number of environmental 

sensors from an assortment of different vendors. At its core, iChart consists of four main 

features: graphical instrument control, powerful data reports, virtual display basemaps, and 

internet data posting.  

1.1 Graphical Instrument Control  

An environmental monitoring tool must be powerful and easy to use. iChart has an intuitive and 

fully integrated workspace interface.  The built in navigation panel makes it easy to select 

between various iChart views: Basemap, Virtual Instrument Control and Report. 

iChart automates much of the tedious programming required with other data logging systems.  

Simply point and click on options in dialog boxes and your iSIC data logger is setup and ready to 

begin collecting data. 

 

Key Features: 

• Easily navigate-able 

• Extensive Multi-Vendor Library 

• Highly graphical user interface 
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1.2 Multi-Vendor Device Library 

The simplicity of iChart begins with with its extensive library of predefined device drivers for 

popular environmental sensors.  

New monitoring sites are quickly configured by selecting instruments from a drop-down list of 

manufacturers. Generic 4-20mA, analog voltage, SDI-12, and RS485 sensors are also available. 

 

Key Features: 

• Everything is setup without programming 

• Extensive Multi-Vendor Library 

• Hundreds of predefined sensors 
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1.3 Powerful Data Reports 

Many environmental professionals find themselves at the end of a project crunching numbers 

and paging through reams and reams of data. iChart's built-in report generator simplifies the 

entire process.  You can quickly generate reports to include data tables, statistics and plots. Best 

of all you can set iChart to generate these reports automatically.  Months of data can be 

compressed to statistical summaries or daily averages.  iChart makes it easy!  

iChart also offers a 'one- button' export to Microsoft Excel or Adobe PDF. Simply highlight the 

data of interest and click either the Excel or PDF icon on the main toolbar. The program will be 

launched and the data will be inserted into a spreadsheet or PDF file. Features such as 'one-

button' export, simplify your job and improve your productivity! 

 

Key Features: 

• One button export 

• Automatic report generation 

• Powerful graphing and data analysis capabilities 
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1.4 Virtual Display Basemaps 

In addition to plots, data tables and statistics, iChart has a complete library of virtual displays 

and controls to provide visual representation of your data. Temperature can be displayed on a 

traditional mercury thermometer, or wind speed and direction on a wind dial and rain in a 

graduated cylinder.  

Add an aerial photo to your iChart database. Data from sensors can be accessed simply by 

clicking on their location in the photo. Data presentations are easy with an aerial photo in your 

iChart database. You can use an aerial photo to display the exact location of instruments and 

dataloggers. 

See the big picture with iChart. Create a custom basemap and place data source objects on your 

display. iChart will keep your display up to date with the latest data. 

 

Key Features: 

• Pre-built components already designed, simply select a thermometer to add it 

• Full feature set of picture editing capabilities 

• Ability to show real time data as iChart receives it from sensors 

• Easily customizable to your specific application 
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1.5 Internet Data Posting 

Online data is becoming the key component of most real-time environmental monitoring 

systems. iChart software can setup a fully featured datacenter for you, eliminating all the 

website development normally required to create a useful online interface.  View data in graphs, 

data tables, or simply download it for further offline analysis. iChart makes this easy.  All you 

need is a web address, user name and password. 

 

Key Features: 

• Setup and view an online database in just a few minutes 

• Ability to view data in graphical or tabular format 

• Ability to download an analyze data in Microsoft Excel 

• Easily filter and control what data is presented to users 

• No IT staff or web knowledge required, iChart automatically generates the website for 

you! 
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2 Getting Started 
2.1 Running iChart For The First Time 

By default the iChart 6 icon is located on your desktop. Double click on this icon to open iChart 

software. The following screen will appear:   

 

This is the iChart Open Choice menu. From this menu you can perform a variety of tasks as 

detailed in the following pages. 

Open Sample Project  

This option will open a sample iChart database. This allows to you to see all of what iChart is 

capable of. This sample database includes a basemap and several sensors. You will not be able 

to interrogate these devices, but you will be able to have the look and feel of an iChart database. 

An iChart Quick Tour pop up guide will walk you through the main iChart features. It is 

recommended for all first time users to go through the tour to get a feel of how iChart operates 

and a general overview of its features. 
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Open Last Project  

This option will open to the last iChart database used.  

Create New Project  

This option will open directly to the iChart Project File menu.  

 

Enter a filename for the iChart database and click Save.  This is the “iChart Database 

Configuration” file and it contains the setup information for all sensors and iSIC Dataloggers in 

the database.  By default, the file is located in the folder: C:\Program 

Files\NexSens\iChart6\Users and has the extension .ICR.   

This window can also be opened selecting New Project from the File Menu, or by clicking the 

New Project icon from the Main Toolbar 

Open Without Project  

This option will open directly to iChart without a database open. You can then create a new 

database by selecting New Project from the File Menu, or by clicking the New Project icon 

from the Main Toolbar. This will open the Create New Project window. 

 

 

 

 

 

The Open Option window can be disabled so it does not come up at the start of iChart. You can 

re-enable this window by going to Edit | Preferences and then placing a check next to the 

Enable startup dialog box. When the Open Option menu is disabled, iChart will open by 

default to Open Last Project. If an iChart database has never been opened, then iChart will 

default to Open Without Project. However, you can choose which items you would like to 

auto-load when starting iChart from the Edit | Preferences menu. 
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2.2 Keeping iChart Up to Date 

From time to time NexSens will release new versions of iChart software as well as iSIC firmware 

that adds new features, expands on old ones, or adds more reliability to the system.  

To obtain the latest versions of software and firmware, in iChart, go to Help | 

Check for Updates: 

iChart will check the NexSens website for a more up to date version of software. 

If you are running the latest version iChart will let you know.  

 

 

However, if there is a newer version of iChart available a dialog box will appear asking if you 

would like to upgrade to this version. 

If you click Yes, iChart will begin downloading the update. Please note that depending on your 

connection speed, this update may take a while. Feel free to do other things on the computer 

while the download is progressing. 

When it has finished downloading, simply click OK, and restart iChart. When iChart restarts it will 

begin the installation process. Click Next to install iChart. 

 

After following the installation windows, iChart will be successfully updated. 
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3 Working With Devices 
3.1 iChart Software and iSIC Firmware Updates 

NexSens periodically releases new versions of iChart software and iSIC firmware to be 

downloaded free of charge. The updated versions typically add new features, improve existing 

features, and/or add more reliability to the system. It is important that iChart is updated to the 

latest version before connecting a new sensor to your iSIC data logger. Your computer will 

require internet access to update automatically.  

To obtain the latest versions of software and firmware, in iChart, go to Help | 

Check for Updates: 

iChart will check the NexSens website for a more up to date version of software. 

If you are running the latest version iChart will let you know.  

 

Otherwise it will ask you if you would like to update, and then begin to do so automatically.  

After obtaining the latest software, you can then perform a code update on an iSIC data logger. 

Select Advanced | iSIC | Code Update to open the Code Update  

 

Select the telemetry option used to communicate with the iSIC, as well as the iSIC address.  

 

When iChart is finished updating the iSIC firmware, simply click Done and continue with normal 

operation. 
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3.2 Setup Device Wizard 

The following guide explains the process of creating a new iChart database and adding devices to 

it.  No programming is required to add devices to the database.  All setup is done through a 

series of easy-to-use dialog boxes.  Instructions for setting up specific sensors can be found at: 

http://www.nexsens.com/support/manuals.htm  

To add the device to an existing database, select Project | Setup Device Wizard. To create a 

new database, select File | New Project. The Setup Device Wizard will begin. Click Next to 

continue. 

 

3.2.1 Step 1 – Site Setup 

 

The first step is to create a site for data loggers and sensors to be located in. If this is an existing 

project, sites may already exist. Enter a Site Name and click Add. 
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3.2.2 Step 2 – Data Logger & Telemetry 

 

The next step is to add the data logger(s) to the sites created in the previous step. Select a site 

to add a data logger to. Then select the data logger model number from the list at right and click 

Add. 

 

The iSIC Data Logger Communication Properties dialog box will appear. Enter the required 

iSIC data logger connection information (see below for model-specific instructions) to finish 

adding the data logger to the selected site. When complete, click OK. 

For an iSIC data logger, enter the iSIC address and select the PC COM Port that the data logger 

is connected to.  

� The iSIC address is typically ‘1’. If unknown, enter ‘0’ and click Test Connection to 

determine the address.  

� The PC COM Port drop-down menu is the list of available COM ports iChart detected on 

the computer. 
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For a 2100-iSIC, enter the 2100-iSIC address, phone number, and PC COM Port that the 

computer phone modem is connected to.  

� The 2100-iSIC address is typically ‘1’. If unknown, enter ‘0’ and click Test Connection to 

determine the address.  

� The PC COM Port drop-down menu is the list of available COM ports iChart detected on 

the computer. Internal PC phone modems are typically set to COM3. 

 

 

For a 3100-iSIC, enter the 3100-iSIC address and the IP address of the data logger.  

� The 3100-iSIC address is typically ‘1’. If unknown, enter ‘0’ and click Test Connection to 

determine the address.  

� The IP address is provided by the cellular service provider in which your cellular data 

account is setup. The port is set to 500 by default.  
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For a 4100-iSIC, select the method in which the 4100-iSIC is connected to your PC and 

enter the 4100-iSIC address.  

� A 4100-iSIC can connect to a PC through a 4100-BASE or a 4200-iSIC. 

o A 4100-BASE system connects to a PC via RS-232 cable.  

o A 4200-iSIC connects to a PC via landline telephone. 

� The 4100-iSIC address is ‘1’ by default. 

o If there is more than one 4100-iSIC in use, each 4100-iSIC should be 

programmed with different addresses (See the 4100-iSIC | iSIC Addressing 

section in the iSIC manual).  

 

 

 

For a 4200-iSIC, enter the iSIC address and PC COM port the data logger is connected to.  

� The 4200-iSIC address is typically 250. When communicating with a 4200-iSIC, any 

communication using the 4200-iSIC address will be sent to the 4200-iSIC data logger.  

o Communications using any other address will be broadcast to any 4100-iSIC(s) in 

your radio network.  

Note: Do not use address ‘0’ when communicating to a 4200-iSIC. 

� The drop down menu of PC COM Port’s is the list of available COM ports iChart detected 

on the computer. Internal phone modems are typically set to COM3. 

 

3.2.3 Step 3 – Sensor Setup 

 

After selecting a data logger, click Next and select the sensor manufacturer from the drop-down 

list of manufacturers. Then select the model number associated with your device and click Add. 

If the sensor you are adding is not in the list, select Generic as the manufacturer and click on 

the sensor type.  
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The Sensor Properties dialog box will come on the screen. Fill in the required sensor 

information. Most sensors will already have all of their information provided and you will simply 

need to select the address, channel, or port the sensor uses. Click Show Detail to display more 

options. 
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Click OK and the sensor will be added to the selected data logger. More sensors can be added at 

this time by selecting the sensor manufacturer and then sensor model number from the drop 

down menu on the right. Click Next when finished adding sensors. 

 

 

3.2.4 Step 4 – Output 

 

Enable any output and control features of the data logger.  

 

See section iSIC Controls for more information on this functionality. 
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3.2.5 Step 5 – Log 

 

Select each data logger from the site list and enter the desired Log Interval and Sample 

Interval for the data logger in the Interval section. In the Log Value section, select how the 

data logger should log data points. 

 

Log Mode 

 

The Log Mode controls when data is logged by an iSIC. In Time-base (the default and most 

common), data is logged at a specified interval, controlled in the Time-base section. In 

Event-base log mode, data is only logged when a ground pulse is sent to the Rain input pin 

on the iSIC digital terminal strip (such as from the contact closure of a tipping bucket rain 

gauge).   

 

Log Value 

 

By default, the Sample Interval and Log Interval are equal. When a sampling interval is 

different than the log interval, all the sampled measurements for the iSIC are used to 

calculate the average, minimum, or maximum of that logging interval (based on the log 

type selected, only one can be selected at a time). The individual data points that comprise 

the samples are not saved; only the final, average, minimum or maximum data point is 

saved at the specified log interval.  

 

Log Memory Mode 

 

The default memory mode is Roll over, and is the recommended operating mode. In this mode, 

the last ~150K readings (when using 512K flash) will be stored in iSIC memory. When the iSIC 

memory has filled with readings it will “roll over” the original readings and keep logging. This is 

ideal for real time applications, where data is being uploaded to a PC as  

In Stop memory mode, the first ~150K readings (when using 512K flash) will be stored in the 

iSIC memory. When the iSIC memory has filled with readings, it will stop logging until memory is 

cleared. When operating in this mode, it is recommended that memory is cleared every time 

data is uploaded. 
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3.2.6 Step 6 – Finish 

 

All data loggers and sensors must be programmed before data collection can begin. 

� Select an iSIC data logger and click the ‘Program iSIC’ button. Before programming an 

iSIC: 

o The iSIC must be powered and connected to the computer. 

o The 2100-iSIC must be powered and connected to a phone line.  

o The 3100-iSIC must be powered and have a cellular data account. 

o The 4100-iSIC must be powered and be able to communicate to the computer 

through a 4100-base or 4200-iSIC 

� Click Finish when programming is complete. This screen can always be revisited by 

selecting Project | Setup Device Wizard if you would like to program an iSIC at a later 

time. 

 

 
 

 

After your sensor has been added to the database, the main instrument control screen will 

appear. 

Important: All parameters are initially displayed with blank values until after the first log 

interval has passed and data has been interrogated.  Once data has been retrieved from the 

iSIC, these fields will show the most recent data set recorded by the instrument. By default, 

iChart will automatically interrogate devices five minutes after every hour. 

 



NexSens Technology, Inc. 

iChart Software Operations Manual 25

3.3 Retrieving Data From Sensors 

3.3.1 Manually Interrogating Data 

 

Data is retrieved by the process of “interrogating” each sensor in the iChart database.  Sensor 

data may be downloaded manually by clicking the Interrogate button, or users can configure 

an automatic “interrogation schedule” through iChart. By default a one hour automatic 

interrogation schedule is set. This means that at the beginning of every hour, iChart will 

automatically interrogate every sensor in the database. 

To manually interrogate sensors, click the Interrogate button as shown below: 

 

If you would like to automatically retrieve data at an interval other than one hour, simply change 

the auto-interrogation schedule. 

The auto-interrogation schedule is located within the schedule dialog box in iChart by clicking the 

Schedule button as detailed in the following section. 

 

The Turn ON live data button starts streaming live data to the iChart computer from the 

sensors connected to the data logger. This allows you to receive an immediate, real time reading 

from the project site. This data is not logged into the iChart database and is only for real time 

data display.  

Data will be updated as often as it can be retrieved from the sensors. For example, if an SDI-12 

sensor connected to the data logger takes a minute and a half to return a reading the reading on 

the screen will be updated every minute a half.  
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3.3.2 Automatically Interrogating Data 

 

iChart can be configured to automatically interrogate devices and retrieve data on a user-defined 

schedule. Set an Interrogation Schedule by clicking the Schedule button on the main 

instrument control screen.  

 

iChart will interrogate the device on 

the days indicated.  Place a check in 

the box for the days you wish to 

retrieve data.  To interrogate the 

sensor every day of the week, select 

each box as shown in the screenshot. 

iChart will interrogate the device one 

time during the interval specified in 

the Every ? Minutes field.  For 

example, if this field is set to 60 

minutes, iChart will interrogate the 

device once an hour. 

 

 

iChart can be prevented from interrogating the device outside the times indicated in the 

Between ? and ? fields.  When these fields are left at their default values iChart will interrogate 

the device during all hours of the day. iChart will only interrogate between the times specified in 

these fields. 

If you would only like to interrogate at specific times throughout the day, click the At field. Up to 

four specific times can be set in the At field. If a time is set in one of these fields, iChart will only 

interrogate the device at that time. 

Some sensors (ie. multi-parameter water quality sondes) require a certain amount of warm-up 

time before taking measurements.  Enter an Offset (in seconds) in this field to force iChart to 

wait for a period of time before interrogating the device. 

To disable automatic interrogation, uncheck the box next to Enable. This box is checked by 

default. 

3.3.3 Pausing and Un-Pausing Auto-Interrogation 

 

During some situations it may be necessary to prevent iChart from automatically interrogating 

devices in the iChart database.  Interrogation can be paused by selecting the Pause Auto-

Interrogation command from the Project menu.  Resume automatic data retrieval by selecting 

the Unpause Auto-Interrogation command.  
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3.4 Changing iSIC Configuration and Setup 

3.4.1 iSIC Configuration and Setup 

After a project has been setup, there are two ways to change the configuration and setup. 

To add new project information, select Project | Setup Device Wizard from the iChart menu. 

This will open the iChart wizard to add new project information. 

   

 

To change existing sensors and data logger configuration, right click on the data logger or sensor 

in the navigation panel and select Property. 

 

This will open the specific devices information and allow you to:  

• Change the site name and description in the Property selection of sites. 

• Change the iSIC address and COM port used by iChart to communicate with a data 

logger in the Property selection of data loggers. 

• Change sensor parameters, ranges, ports, and other sensor information in the Property 

selection of sensors. 

• Change parameter names, units of measure, and scaling in the Property selection of 

parameters. 
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3.4.2 iSIC Power Management 

 

By default, all iSIC’s are set to continuously power telemetry such as a spread spectrum radio or 

cellular modem. However, in battery powered applications where limited solar charging is 

available or the current consumption of sensors is high then it may be advisable to use a power 

schedule. 

Power schedule allows you to set when the iSIC telemetry will be powered on, and when it will 

be powered off. This feature is useful for 4100-iSIC, 3100-iSIC, and 4200-iSIC models and is not 

used in direct connect, analog phone line, or stand alone systems. 

 

Select the iSIC you would like to setup power management for in the Navigation Panel. Then 

click the Setup button and go to the Schedule tab. At the bottom of the window there is a 

Switched Power Schedule section.  

You have three options for power management. Continuous, Fixed time, or Periodic. 

• In continuous mode operation the iSIC will be powered on continuously 

• In fixed time mode the iSIC will only power on at the set time and will turn off after the 

duration has expired. 

• In periodic mode the iSIC will turn on at every interval for the specified duration. 

Note: you will be unable to communicate to the iSIC during the times that it is powered off. It is 

recommended that you also set a “Sync RTC Schedule” to make sure that the iSIC clock matches 

the PC clock at all times, ensuring you that you know when it is on or off. 

Note: If you are using power schedule and the iSIC is scheduled to be off but you need to talk to 

it you can do so by cycling power. After cycling power you will have five minutes to change the 

power schedule if you would like. 
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3.5 Scheduling 

The main instrument control screen allows you to configure automatic scheduling. 

3.5.1 Automatic Interrogation Schedule 

 

iChart can be configured to automatically interrogate devices and retrieve data on a user-defined 

schedule. Set an Interrogation Schedule by clicking the Schedule button on the main 

instrument control screen.   

 

 

iChart will interrogate the device on 

the days indicated.  Place a check in 

the box for the days you wish to 

retrieve data.  To interrogate the 

sensor every day of the week, select 

each box as shown in the screenshot. 

iChart will interrogate the device one 

time during the interval specified in 

the Every ? Minutes field.  For 

example, if this field is set to 60 

minutes, iChart will interrogate the 

device once an hour. 

 

iChart can be prevented from interrogating the device outside the times indicated in the 

Between ? and ? fields.  When these fields are left at their default values iChart will interrogate 

the device during all hours of the day. iChart will only interrogate between the times specified in 

these fields. 

If you would only like to interrogate at specific times throughout the day, click the At field. Up to 

four specific times can be set in the At field. If a time is set in one of these fields, iChart will only 

interrogate the device at that time. 

Some sensors (ie. multi-parameter water quality sondes) require a certain amount of warm-up 

time before taking measurements.  Enter an Offset (in seconds) in this field to force iChart to 

wait for a period of time before interrogating the device. 

To disable automatic interrogation, uncheck the box next to Enable. This box is checked by 

default. 
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Quick Note: 

During some situations it may be necessary to prevent iChart from automatically interrogating 

devices in the iChart database.  Interrogation can be paused by selecting the Pause Auto-

Interrogation command from the Project menu.  Resume automatic data retrieval by selecting 

the Unpause Auto-Interrogation command. 

 

 

3.5.2 Sync iSIC Real Time Clock to PC Schedule 

 

The Sync RTC Schedule is the interval iChart will automatically sync the iSIC clock with the PC 

clock. As with any embedded device, the iSIC clock can drift as much as two minutes per month. 

Especially where power scheduling is implemented, making sure the iSIC time and the PC time 

are the same is important. Set a Sync RTC Schedule by clicking the Schedule button on the 

main instrument control screen.   

 

 

Note: When using a Sync RTC Schedule in conjunction with power management, make sure the 

data logger telemetry will be powered when the auto sync is scheduled to occur. For example, if 

a 3100-iSIC is scheduled to only power on the cellular modem 5 minutes every hour, set the 

Sync RTC Schedule to 2 or 3 minutes after the top of an hour to make sure the 3100-iSIC has 

had time to power on and connect to the cellular network. 
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3.6 Alerts and Alarms 

iChart software allows several kinds of alerts and alarms to be setup and used with iSIC data 

loggers: 

1. iChart Alarms: these alarms are used to notify persons via SMS text messaging or 

email of parameters exceeding pre-defined parameter limits. iChart sends the alarm 

when it receives data from a data logger. 

2. Control Outputs: these alarms are used to control devices via 5V DIO or 12V switches. 

An iSIC data logger controls the device when it receives data from sensors that exceed 

pre-defined parameter limits. 

3. iSIC Alarms: these alarms are used to change the functionality of the data logger based 

on parameter inputs, such as changing sample and log intervals based on a particular 

logged reading.  



NexSens Technology, Inc. 

iChart Software Operations Manual 32

3.6.1 iChart Alarms 

 

iChart software allows you to create alarms when certain parameters go above or below a 

designated value. For example, let’s say you are in charge of monitoring the water quality at a 

fish farm. Why not have iChart send you a text message on your cell phone if the dissolved 

oxygen gets too close to critical levels. Using alarms allow you to be warned immediately when a 

situation is about to occur.  

iChart allows you to: 

1. Generate a sound on the computer speaker 

2. Flash a warning message on the computer 

3. Play a specified .wav file 

4. Send an email message 

5. Create a text file 

6. Send a text message to a cell phone 

7. Control a DIO port on a data logger (for triggering auto samplers, etc) 

 

iChart allows you to use two different kinds of alarms: iChart or iSIC based. iChart alarms send 

an alarm when data is received in iChart from an iSIC data logger. 

 

Every time iChart receives data from a device it checks to see if the values of that data exceed 

an alarm threshold. If it does, an alarm will activate.  

PC Alarms allow you to have a certain event occur whenever a parameter goes above or below a 

certain point. From the Navigation Panel select the device you would like to have an alarm for. 

Then in the main instrument control screen, click the Setup iChart Alarm from the Project 

menu.  Then select the parameter you would like to set an alarm for.  

Click Add to open the Define Alert/Alarm dialog box. 
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The Define Alert/Alarm dialog box sets up a single alarm condition. To add multiple alarm 

conditions, add them one at a time by click the Add button on the main alarm screen. 

The Enable button enables the alarm. If you 

would like to stop an alarm from occurring during 

a period of time that you know a problem will 

arise, simply uncheck the Enable box. All the 

alarm information will still be saved. 

The Category, either Alert or Alarm, specifies 

what kind of text that is used when an alarm 

occurs. Both alerts and alarm categories function 

the same in iChart. 

The alarm Type can either be: High threshold, 

Low threshold, or Data Flag. Data flag alarms are 

used to alarm on pre-defined data flag conditions. 

These flags are setup in the Project | Setup 

iChart Data Flag menu. 

 

The Set Value is the value you want the alarm to trigger. For example click on Temperature C 

on the left hand column and enter 50 for the Set Point. This means that if the temperature goes 

above 50oC, an alarm will occur. This value can also be configured as a range instead of a set 

point, such as only alarm when temperature falls between 50 oC to 100 oC. A range alarm, used 

in conjunction with a set point alarm can allow you to send an alarm to an engineering technician 

if the temperature is reading out of theoretical range (because of sensor failure or malfunction) 

and send real alarms (caused by hot water) to a different person in charge of water 

temperature.  

The Reset Value is the value at which the alarm will allow it to trigger again. For example; if the 

temperature went above 50oC an alarm would occur just once. If the Reset Point is set to 45oC, 

then the alarm will not occur again until the temperature drops down below 45oC. This feature is 

useful to prevent alarms from continuously occurring if temperature is jumping from 49.1oC to 

50.1oC for example. 

The Count is the number of times the condition has to occur before the alarm actions will occur. 

The count is based on the data logger sample interval. For example, if the sample interval is 5 

minutes and the count is 3, the alarm action would occur after 15 minutes of the alarm 

condition. This feature is useful to prevent data spikes from causing alarm actions, such as 

turbidity jumping to a large value due to a leaf floating by, etc.  

After setting the alarm conditions, click on the ‘…’ button located on the far right of the Alarm 

Action field. 
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A window will appear that allows you to select the type of alarm you would like to use. Click on 

the drop down menu and select one of the following alarms. After you have set up the alarm 

action you can go back and setup the second alarm or  

 

Acknowledging an Alarm 

When ever an alarm triggers, an Alarm Toolbar will be displayed. This tool bar allows you to 

acknowledge the alarm, and stop it from carrying out until the reset point is reached. Click on 

the picture of the speaker with a red circle to end the alarm. 

 

Alarms can be temporarily disabled without deleting alarm setup information by clicking Edit and 

then unchecking the Enable box. 

Generate a sound on the computer speaker 

 

Selecting Sound PC speaker will generate a 

continuous computer beep until the alarm is 

acknowledged. 

 

Flash a warning message on the computer 

 

Selecting Flash message will flash the message 

specified in the Message field until the alarm is 

acknowledged. 
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Play a specified .wav file 

 

Selecting Play wave file will continuously 

play the specified wave file until the alarm 

is acknowledged. Specify the wave file by 

clicking the ‘…’ located to the far right of 

the Wave File field. 

 

For your convenience, a few wave files are 

located in: 

C:\Program Files\NexSens\iChart5\System 

Simply select one of the .wav files that you 

like. You can test these file before hand or 

download your own alarm from the 

internet. 

 

Send an email message 

 

Selecting Send email message will send an email 

to the specified email address in the Email Address 

field. The subject line of the email is “ALERT”. And 

the body text is the text entered into the Message 

field. A new email will not be sent on alarm until the 

reset value has been reached. 

Note: your email information must be correctly 

setup in the ‘Edit | Preferences’ menu for this 

alarm to work properly. 

Create a text file 

 

Selecting Create File will create a text file with the 

designated File Name and with the text body of 

Message field. This file is saved in the current 

selected folder. By default this is:  

C:\Program Files\NexSens\iChart5\ 

If you want to save the file in G:\Temp\ simply enter 

“G:\Temp\warning.txt” in the File Name field. 
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A new file will not be saved on alarm until the reset 

value has been reached.  

 

Send a text message to a cell phone 

 

Selecting Send SMS message sends a text 

message to the cell phone number designated in the 

Phone number field. The text message is the text 

set in the Message field. 

A new text message will not be sent on alarm until 

the reset value has been reached. Note: text 

messaging must be enabled by NexSens Technology 

before use. 

 

Pulse iSIC DIO 

 

Selecting one of the Pulse iSIC xxx alarm 

options allows iChart to trigger a data logger to 

exercise control functionality.  

 

If you would like to implement iSIC controls on a 

data logger based on a parameter that data logger 

is logging, it is best to use a Control Output alarm 

instead of an iChart alarm. 

 

The real advantage of this kind of iChart alarm is 

it allows you to control a data logger based on a 

parameter from another location. For example if 

an upstream site detects a certain amount of 

turbidity in the water, this iChart alarm can be 

used to initiate a sampler on a downstream data 

logger.  

 

The iSIC ID field is the data logger you would like 

the alarm to trigger. This is the number in the 

bracket next to the data logger (ie enter ‘1’ in the 

iSIC ID field if the data logger name in the 

navigation panel is ‘3100-iSIC[1]’). 
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3.6.2 Control Outputs 

 

Parameter alarms configured on the iSIC data logger allow you to setup and configure controls to 

do things such as flash warning lights, trigger ISCO samplers, etc. The iSIC allows two kinds of 

control, 5V digital I/O and 12V 100mA switches. 

 

On the Input/Output tab of the Setup Device Wizard iSIC alarm controls can be setup. 

Select the data logger you would like to configure and click the Add button under Control 

Output. 

Place a checkbox in Enable iSIC Output Control and give it a name. This name will be used 

when identifying this control. 
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Click the Add… button to open the iSIC Control Output Condition dialog box.  

 

 

 

 

A control condition is checked by the data logger every sample interval. To setup a condition: 

1. Pick a parameter from the drop down list 

2. Select a parameter condition (such as greater than or less than) as well as a parameter 

value and count (see below). 

 

The Count is the number of times the condition has to occur before the alarm actions will occur. 

The count is based on the data logger sample interval. For example, if the sample interval is 5 

minutes and the count is 3, the alarm action would occur after 15 minutes of the alarm 

condition. This feature is useful to prevent data spikes from causing alarm actions, such as 

turbidity jumping to a large value due to a leaf floating by, etc.  

 

Click OK and then click Edit in the Control Output section to open the iSIC Control Output 

Action dialog box. 

 

Select the Action and channel to perform the alarm on. The options are either 5V DIO or 12V 

100mA switches. SW.A, DIO.0 and DIO.1 are available on the green digital terminal strip on 

each iSIC data logger.  

 

Click OK and finish the Setup Device Wizard to complete the setup. 
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3.6.3 iSIC Alarms 

iSIC alarms are used to change the functionality of the data logger based on parameter inputs, 

such as changing sample and log intervals based on a particular logged reading. 

 

To enable an iSIC Alarm: 

1. Click the Setup button and go to the iSIC Alarm tab. 

2. Place a check in the Enable iSIC Alarm checkbox. 

3. Click Add to enable an alarm condition, such as level above 0.20 feet as shown below. 

See the description of count in the page above. 

 

 
 

4. Click the Edit button and select the alarm type. Options include: 

a. For any iSIC type: Changing the sample and log interval 

b. For a 3100-iSIC AT&T/Cingular modem: Sending an SMS message or SMTP email 

5. When finished setting up the alarm, click Update iSIC to send the configuration to the 

data logger. 

 

 
 

Note: iSIC alarm conditions are evaluated each sample interval. For example, if a data logger is 

set to sample every 60 minutes under normal conditions, and a Change log interval alarm is 

selected, it will check the alarm condition every 60 minutes to determine if it should switch to the 

different interval. 
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3.6.4 Monitoring Critical Projects 

 

 

Due to the nature of many environmental 

projects, immediate notification of failures is a 

necessity for many project managers. The iChart 

System Monitor allows a project manager to 

receive critical messages such as failure to 

retrieve data or upload data online. 

 

 

The Status tab of the System Monitor sets the 

schedule the iChart project status information 

should be emailed (Note: an email server must be 

setup in Edit | Preferences for emails to be 

sent). This email includes information such as 

what devices are enabled or disabled, if iChart is 

currently closing, and if auto interrogation is on or 

off. 

 

 

The Alert tab of system monitor sets the 

schedule and conditions iChart will send an alert 

email. These conditions include auto interrogation 

failures, data not being up to date, failure to post 

data online, and the reporting of any error codes 

in the data, such as missing or out of range 

values. 
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3.7 Filtering Data 

iChart software allows data to be filtered before it is saved into the database. Note that this data 

is filtered before it is put into the iChart database and will therefore not be able to be retrieved. 

The advantage of using this kind of filter is to limit what data is sent to an ODBC connection or 

WQData website. Data can be filtered in reports, post processing, after the data has been saved 

into the database. 

Click on the data logger to configure data filtering on and then select Project | iChart Data 

Flag. 

 

Click Add to open the Define Data Flag dialog box. 

 

This dialog box allows you to replace values exceeding the parameter limit with text values, such 

as Invalid reading, or Out of range. 

Note: the value -100000 means the iSIC data logger was unable to communicate to a 

sensor connected to it. Note that the value returned from the iSIC is not exactly -100,000.  

Thus, to compare to this value, use greater than AND less than logic. 
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3.8 What an IT Administrator Needs to Know 

For most, if not all networks and computers, there should not be any problems running NexSens 

software or hardware. NexSens uses ports and protocols that are generally NOT considered to be 

a security risk. 

For iChart software: 

iChart software is the main software tool used to communicate with data loggers and 

sensors. For a computer to use iChart software the user must have write access to:  

C:\Program Files\NexSens\  

Which is the default install folder. Additionally, when registered (the software comes with 

a FREE 30 day trial) the user must have Administrator writes to the computer as the 

registration information is stored in the Windows registry. 

For Windows Vista, iChart software must be run with the “Run as an Administrator” 

option selected. 

For WQData posting: 

WQData is a web datacenter hosted on NexSens Technology servers. For iChart to be 

able to post data to WQData.com it must be able to FTP files to ftp.wqdata.com on port 

21 and navigate to a URL on www.wqdata.com port 80. 

iChart software uses active ftp to post environmental data to the WQData web data 

center. 

 

In active ftp, the server (ftp.wqdata.com) always communicates on port 21 for 

command and port 20 for data.  The client (iChart), however can decide to send data 

in any port higher than 1023.  The client tells the server which port it wants to send 

data (PORT command).  The server then initiate data request to the client on this 

port to obtain data when it gets the client request to upload file. 

 

Client: send PORT d command 

Server: acknowledge and remember port d 

Client: send PUT file command 

Server: initiate data transfer to client on port d 

 

The client firewall at this point blocks incoming traffic from the server on port d since 

it is initiated from the outside. 

 

For WQData posting to work, the client firewall need to allow incoming traffic from 

nexsensdatacenter.com on all port d that is > 1023. 

 

Currently, iChart uses the Microsoft Windows build-in INET library for ftping.  INET 

sends PORT d command automatically picking an unprivileged port 1024 or higher.  

The ftp log file shows that this port changes each time at random. 

 

For additional information, please contact NexSens technical support. 
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For Email alarms: 

iChart can be configured to use either SMTP or MAPI for email alarming. For SMTP, iChart 

will need to know the SMTP server address, server port, the username and password for 

an email account on the server as well as the authentication type. 

For running iChart software on Windows Vista: 

The NexSens engineering team has evaluated compatibility issues between the iChart 

product line and the Vista operating system. NexSens runs Vista on employee machines 

(specific versions include Vista Home Basic and Vista Enterprise). iChart is used several 

times a day with different configurations and systems (for development, tech support, 

and testing). Most of the Vista specific requirements involve the changes in Vista 

program security that requires additional administrative rights to use software. 

To date the engineering team has found the following Vista requirements: 

o The user logged into the computer must have administrative rights to install and 

run software (cannot be a User account) 

o iChart does not support Aero Vista theme 

o iChart must be run as an administrator (right click on shortcut and go to 

compatibility tab, there is a checkbox for Run as Administrator) 

o iChart must be registered after install (the 30 day trial does not run in Vista) 

 

Contact NexSens technical support for any additional information. 
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4 Working With Data 
4.1 Data Reports 

Data may be presented in one of three ways within an iChart report – Statistics, Graph, and 

Table.  In addition, users may also include information specific to the report such as the physical 

location of a sensor and name of the monitoring project.  Users can choose which modes to 

include in a report – simply turn off the modes that you wish to hide. 

 

To configure an iChart data report, use the integrated Report Tools.  The Report Tools are spread 

across four tabs located on the bottom of the Report Toolbar – General, Graph Properties, 

Output, and Advanced.  

The report interface in iChart is fully interactive and changes to reports are displayed instantly.  

By default, iChart will generate a daily report and display data from the first monitoring 

parameter in statistic and graph format.   
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To include additional parameters in the report, click on the + 

signs to expand the parameter selection. Place a check in each 

box next to the desired parameters.  

Please note that once a new parameter is selected, the report 

will update instantly.  Depending on the amount of data in the 

database, there may be a small pause.  Wait for iChart to 

update the report before selecting another parameter. 

 

In addition to selecting which parameters are reported, iChart 

allows you to fully customize all other aspects of the report: 

 

iChart includes standard templates for daily, monthly, and 

yearly reports.  In addition, reports containing the entire 

database may be generated.  Select these options in the 

“Time Limit” section of the Report Toolbar.   

 

 

iChart will display data in statistic, graph, and table formats.  

Statistics include the average, minimum, maximum values, 

and standard deviation of each parameter.  Check the “Data” 

box to display data in that table format.   

 

 

iChart allows you to auto-align data based on time. This 

feature is very useful when generating reports using multiple 

sensors that do not necessarily have the same time interval 

between data points. By default, no data alignment is 

selected. If you would like to align data to minute intervals, 

simply select UserDefined and enter the number of minutes 

you would like to align the data to. 

 

In addition, reports can be exported to Microsoft Excel or converted to PDF and saved in a local 

folder.  Options are available for automatic report generation, sharing of reports via e-mail, FTP, 

folders, and more. 

Click the PDF icon on the Main Toolbar to output the current data report in Adobe 

Acrobat PDF format.   

Click the Excel icon on the Main Toolbar to output the current data report in Microsoft 

Excel format. 

iChart contains many more advanced features related to the Historical Data Report tool.   
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4.1.1 Automatic Historical Data Report Creation and Sharing 

iChart software is a data collection and analysis tool, designed to collect and store environmental 

measurements from remote sensing devices.  As such, historical report creation is one of the 

core components within iChart software.  Create a new historical data report by selecting the 

New Report command from the Report Menu or simply click the New Report icon from the 

Main Toolbar. 

  

 

Report creation tools in iChart software are fully interactive, and changes to a report’s settings 

are displayed instantly.  Report Mode is divided into two main sections.  The data report is 

displayed in the middle of the screen in HTML format.  The Report Toolbar is located on the 

right of the screen.  This toolbar contains all the functions used to create a historical report. 
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Report Output Destination and Format 

 

iChart can output reports in CSV (comma-separated value), PDF, and IDB (iChart Database 

Backup) format.  CSV reports can be opened using popular spreadsheet programs such as 

Microsoft Excel.  PDF reports are opened using Adobe Acrobat Reader.   

Click the Output tab  of the Report Tools to define the report’s 

Output Format and Destination. This tab is located at the bottom of 

the Report Tools menu.   

Check the Enable Auto Report field to enable the auto report 

feature. 

iChart can then be configured to generate reports and send them to a 

specific destination.  By default, iChart will simply display the report 

on your PC monitor once it is created.  Options are available to send 

reports directly to your PC or LAN folder, e-mail address, or an FTP 

server. 

To send a report to a PC or LAN folder select Folder from the 

Destination drop down menu. Next click on the “…” button, and 

browse to the folder location you would like the reports to be saved. 

To send a report to an e-mail address, select Email from the 

Destination drop down menu and enter the target recipient in the 

address field.  Send the report to multiple recipients by placing a 

semi-colon after each e-mail address in the field.  

To send a report to an FTP server, select FTP from the Destination 

drop down menu and enter the server’s URL in the field. For example, 

ftp://www.myftp.com.  Enter the username and password used for 

server login in the indicated fields.  

You may also have iChart send reports to your computers default printer. Select Printer from 

the Destination drop down menu.  

iChart can save the reports in CSV, PDF, or IDB format. Select the type of report you would like 

to auto-generate. 

If the Use fixed file name field is checked, the file name of the report will be saved as the 

name entered into the blank field below the check box. Keep in mind that iChart will 

automatically write over the previous report with the newly generated report if this feature is 

used. 

Note: IDB is a custom format, designed specifically to hold a portion of the iChart database.  If 

this output format is selected, the IDB can be opened directly in iChart through the Restore 

command found in the File Menu.   

You must set an Auto Report Schedule before iChart will begin automatically generating reports. 

See the following section for details creating this schedule. 

Note: All information entered into the Report Tool menus will not be saved until the user clicks 

on another menu. 
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Automatic Report Schedule 

 

A common application for iChart is the automatic creation of historical reports when the PC has a 

real-time connection to an environmental sensor.  iChart can be configured to generate data 

reports on a user-defined schedule and save them in a variety of locations. 

Click the Output tab of the Report Tools to define an automatic report generation schedule.  

Check the Auto Report Enable box to enable automatic report generation. You must then set 

the Auto Report Schedule to have iChart automatically generate reports at the given times. 

iChart will generate reports only on the days indicated by the 

Day drop down menu. By default, no days are selected. Place a 

check in the box for the days you wish to create new reports.  To 

create reports every day of week, select each check box as 

shown. The drop down menu will then display an abbreviation of 

every day selected in its drop down menu bar. For example, if 

Sunday and Monday are selected, then it will show Sun, Mon. 

 

You will then need to set up the frequency intervals that the 

reports will be generated. iChart has two different types of 

frequency intervals: periodic and fixed times. 

If you would like iChart to generate reports periodically, then click 

on the circle next to the Every ? Minutes drop down menu. You 

can configure iChart to generate a report at minute intervals 

specified by the Every ? Minutes field. Simply enter the number 

of minutes you would like to be between each generated report.  

For example, if this field is set to 60 minutes, iChart will update 

the report once an hour. 

You can also specify the allowable times iChart can generate 

reports. iChart can be prevented from interrogating the device 

outside the times indicated in the Between ? and ? fields.   

When these fields are left at their default values iChart will 

interrogate the device at every interval specified by the Every ? Minutes field. This feature is 

useful when the device is only on during certain times or if you would only like to interrogate 

during the day.  

If you would like iChart to generate reports at fixed times, then click on the circle next to the At. 

You can configure iChart to generate a report at specific times throughout the day, determined 

by the At fields. Up to four specific times can be set in the At field. iChart will only interrogate 

the device at that time.  

Enter an Offset (in seconds) in this field to force iChart to wait a specified length of time 

before updating the data report. For example, if you would like iChart to wait 5 minutes after the 

hour to generate a report, enter 300 into this field. 
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More Report Options 

Additional report options are available in the Report | Other Setup screen.  

 

This window will allow you to: 

1. Change the unit of measurement of a parameter for this report 

2. Allow you to display the data table in descending order (last reading 

on top) 

3. Allow you to create interval reports (ie. Last 30 days (September 18th to 

August 18th), instead of last month (September 18th to September 1st). 

 

 

The first tab of Other Setup is the Unit tab. Here 

you can select the parameter you would like to 

change the unit of measurement for from the menu 

under Parameter. Then on the right, select the new 

desired unit of measurement. Note: this unit change 

only affects the current report. 

The second tab of Other Setup is the Misc tab. Here 

there is a checkbox for if you would like the report 

data table to display the data in descending order 

(last reading on top). Additionally you can change the 

type of report that is generated. By default, Current 

is selected.  

 

Fixed means whatever time period you have selected 

for the report, the report will always use that time 

period. So if you made a report with a time limit with 

the current month of data, next month this report 

would still be of last month. 

Current means that whatever time period you have 

selected will be based on the current time. For 

example, if you select month as the time limit the 

report will always show the current month. So this 

month the month time limit will show this months 

data and next month this report would show next 

months data. Note: these changes only affect the 

current report. 

Previous means the report will always show the previous interval to what you have selected. So 

if you have month as the time limit the report will show last month. 

Interval means it will always show the last interval. For example if you have month selected it 

will show the last 30 days. If you enter 9/18/2006 in the To field and 9/16/2006 in the From 

field it will always show the last 2 days of data in this report. This feature is useful in auto 

generated reports where you always want to show the last xxx days of data in the report. 
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4.1.2 Report Tools 

The report tool bar is shown in the report screen on the right hand side.  The tabs are located at 

the bottom of the panel.   

Time Limit 

All – Includes all data from the iChart database in the report.  

Daily – Includes all data from the selected day in the report. 

Monthly – Includes all data from the selected month in the report. 

Yearly – Includes all data from the selected year in the report. 

From To – Includes all data between the selected dates in the 

report. 

Include 

Reports generated by iChart may include a project summary, data 

statistics, graphs, and data tables.  Place a check in the boxes to 

include these components in the report.   

Statistics – Displays a Statistical Summary for each parameter in 

the report.  Includes number of samples, average value, minimum 

value, maximum value, and the standard deviation for each 

parameter. 

Graph – Generates separate data graphs for each parameter and 

displays them within the iChart report.   

Data – Display data for each parameter in table format. 

Summary – Displays a Summary within the iChart report. 
 

Settings – iChart has addition settings in the Report Summary dialog box that appears once 

this Settings button is pressed.  This is used to decide what information is displayed in the 

summary when included in the report.   

All fields in this dialog box will show the text entered in the corresponding place in the report.   

Show detail field note – If you do not wish to see field notes on reports, uncheck this check box. 

This option is checked by default. 

   

Time Resolution  
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iChart allows you to auto-align data based on time. This feature is 

very useful when generating reports using multiple sensors that do 

not necessarily have the same time interval between data points. By 

default, no data alignment is selected. If you would like to align data 

to minute intervals, simply select UserDefined and enter the 

number of minutes you would like to align the data to. 

Parameter   

 

Place a check mark next to each parameter you want to include in 

the report.  Reports can contain data from all parameters.  By 

default, iChart will not select any parameters.  To display 

parameters, click the folder icon next to the device name and place 

a check next to the parameters you wish to view. 

 

Graph  

 

iChart incorporates an advanced feature allowing the user to place 

multiple traces on a single graph. This feature is very useful when 

comparing multiple parameters together to determine a correlation. 

Up to 12 traces per graph may be combined. iChart will 

automatically place the y-axis onto the graph for each additional 

trace as well as re-color any traces to avoid two traces having the 

same color.  

By default, the graph will display lines in between missing data 

points. The Disjoint Graph option allows you to show gaps in the 

graph where there are missing data points. 

 

This feature is even further enhanced by the Combine same parameter Y-axis button. If 

there is a check next to this field then iChart will combine the y-axis of each trace in the graph 

and redraw the trace as needed to fit this new y-axis. You will notice that when graphing 

multiple parameters together you will see multiple Y-axis on the graph, each one scaled to fit the 

parameter it is for. When you have the box checked it will set all the parameters to use the same 

axis. This makes it easier to numerically compare two graphs. (Note: this feature only works for 

parameters of the same type) 
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Graph Property Tab 

Click the Graph Property tab on the bottom to display options for customizing the look and feel of 

the graphs included in your iChart data report. 

Parameter  

Select a parameter from the list to customize its corresponding 

data graph.  Graphs are configured independently from one 

another, and changes made to one graph will not affect the 

appearance of any others. Only parameters that have been 

checked in the General tab parameters list will show up here. You 

can deselect a parameter by un-checking its corresponding check 

box. 

Note: If you would like to modify multiple parameters at a single 

time, you can select the folder they are in. Doing so will affect 

every device in that folder. You can also select the Site to modify 

every device in that site. 

Graph Scale 

Autoscale – Enable auto-scaling of the graph for the selected 

parameter. 

Lower Limit – Lower y-Axis limit for the graph of the selected 

parameter. 

Upper Limit – Upper y-Axis limit for the graph of the selected 

parameter. 

Graph Appearance 

Back Color – Background color for the graph of the selected 

parameter. 
 

Trace Color – Trace color displayed on the graph of the selected parameter. Note: If multiple 

parameters are on a single graph then iChart will make sure that two traces never have the 

same color. If you select a color for a trace that is already being used iChart will automatically 

change the color of that trace. 

Grid Color – Grid color displayed on the graph of the selected parameter. 

Trace Width – Trace width on the graph for the selected parameter. 

Graph Property 

Note: The first parameter from the Parameter menu must be selected.  

The text entered into these text boxes changes the text at the top of the report graphs. By 

default the X Axis Label is ‘Date’ and Title line 1 is the name of your iChart database. 
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Output Tab 

iChart reports can be output in a number of different formats and sent to a variety of locations.  

Auto Report options are available to send reports to the screen, printer, email, FTP server, 

printer or a folder on your PC or LAN.  Reports may be output in CSV, PDF, and IDB (iChart 

Database Backup) format. 

Enable Auto Report – must be checked for auto reports to be generated. 

Destination 

Display – Displays reports on your PC’s screen when they are 

created. 

Email – Sends reports to the specified e-mail addresses. 

FTP – Sends reports to the specified FTP server. 

Folder – Sends reports to the specified folder.  This folder may be 

located in either a local PC or LAN folder. 

Printer – Sends reports to your PC’s default printer. 

Format 

CSV – Saves reports in CSV format. 

PDF – Saves reports in PDF format. 

IDB – Saves reports in IDB (iChart Database Backup) format.  

Reports generated in IDB format may be opened directly in iChart 

with the Import command in the File Menu.   

Use Fixed Filename – If you wish to use the same filename every 

time iChart saves a report, enter it here.  iChart will overwrite 

previous reports generated with this filename.   

Auto-Report Schedule 
 

Day – Place a check next to each day you would like auto reports generated 

Every ? minutes – used to generate periodic reports. The value in this field is how often iChart 

will generate a report. 

Between ? and ? – iChart can be prevented from updating reports outside the hours set in these 

fields.  Leave these fields at their default value to allow report updates at all times.  

At –If this option is enabled, iChart will update reports only at the times indicated here.  

Offset (sec) – An offset can be entered in this field to force iChart to wait a certain number of 

seconds before updating a report.  This option is typically used when the iChart database 

contains sensors that require a certain amount “warm-up” time before taking measurements. 
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Advanced Tab 

Parameter 

Select a parameter from the list to configure its advanced options.  Changes made to one 

parameter will not affect the settings of any others. You can change multiple parameters by 

selecting the folder those parameters are in. Changes will then affect every parameter in that 

folder. 

Precision  

Sets the number of decimal places for the data shown in statistics, 

graphs, and data table.   

Output 

Avg – Check this box to display average values in the report.  The 

Time Resolution field in the General settings of the Report Tools 

determines the average values. 

Min – Check this box to display the minimum value that occurred 

during the time period defined in the Time Slice field in the General 

Settings of the Report Tools. 

Max – Check this box to display the maximum value that occurred 

during the time period defined in the Time Slice field in the General 

Settings of the Report Tools. 

Std – Check this box to display the standard deviation of the values 

recorded during the time period defined in the Time Slice field in 

the General Settings of the Report Tools. 

Sum – Check this box to display the sum of the values recorded 

during the time period defined in the Time Slice field in the General 

Settings of the Report Tools. 

Samples – Check this box to display the number of samples 

recorded during the time period defined in the Time Slice field in 

the General Settings of the Report Tools. 
 

Include Data 

The Value Limit filters the data sets to be displayed in the report.  A data set includes a 

date/time stamp, and the selected parameters from the General Settings tab of the Report 

Tools.   

All – Display all data. 

X <= ? –  Filter (Do Not Include) data sets above the indicated value. 

X >= ? – Filter (Do Not Include) data sets below the indicated value. 

? <= X <= ? – Filter (Do Not Include) data sets outside the indicated values. 
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Graph Markers 

iChart allows you to mark eight time events on your graphical reports. Click the More button to 

access the additional markers. Select the time and date from the Mark Time drop down menu 

and enter the text you would like displayed next to the mark in the Mark Text text box. This 

feature is extremely useful in marking times when the system was calibrated or offline for a 

period of time.  
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4.2 Using Basemaps 

Base maps are graphical views of your physical system. They are easily created with custom 

images and controls that come pre-made in iChart and only need to be positioned on the screen. 

Thermometers, wind dials, digital read outs, as well as links to data reports, are only a few of the 

controls that are available.  It should be noted that no artistic talent or programming required 

when using these features. 

 

New Basemap 

 

To create a new basemap, select New Basemap from the Basemap menu. 

  

iChart will then ask you for a basemap name. Enter a descriptive name and click OK.  
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Base map Tools 

 

After you have created a basemap, you will need to add background color of 

images, graphical displays, or links to reports. Basemap tools allow you to 

edit your base map displays.  The basemap tools can be hidden or displayed 

using the edit button  in the main toolbar.   

This section will briefly explain a few of the basemap features. Each item of 

the tool set is explained in chapter 7, please refer to the Basemap Tools 

section for more information.   

 

 

 

 

 

 

First we will add a background image. Click the Background Image icon and a 

dialog box will appear. 

Browse for the file you wish to open, select it, and click open. That image will now be displayed 

as the background to your new basemap. 

 

Next, click on one of the display icons, such as 

the thermometer . A dialog box will 

appear. Select the parameter you wish to 

display. You can also select the minimum and 

maximum value to be displayed by the display 

item. When you have finished, click OK. 
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The display object will appear on top of your background image. Note: the reading will not 

update until the basemap has been saved. This is accomplished by clicking on the basemap tool 

icon again.  

 

 

 

 

To add a link to your basemap, click the Datasource Object button . Select the 

image for your link from the drop down menu and place it on the basemap. 

 

 
 

 

A Control Object Property dialog box will 

appear.   

These features are used to control the actions 

executed when clicking on a link.   

 

 

Data Source Link – From the drop down menu, select the device you wish to link your link object 

to. All devices in your database will be listed. Select Interrogate from the Default Left Mouse 

Action section. Whenever this link is click on, iChart will interrogate the specified device. 

Report Link – Click browse and select the report you wish to link to.  Reports are found in 

*.Report folders located in C:\Program Files\NexSens\iChart5\Users. Where * is the name of the 

database. Select Report from the Default Left Mouse Action section. Whenever this link is 

clicked on, iChart will open to the report specified here.   

Custom View Link – From the drop down menu select the basemap you wish to link your link 

object to. All basemaps in the project will be listed. Select View from the Default Left Mouse 

Action section. Whenever this link is click on, iChart will open to the basemap specified here.
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Storing Data into Other Databases (ODBC Compliant) 

While iChart has its own database format and a set of rich web and reporting tools, some users 

may prefer to use their own custom database to store the data or need to use an existing 

database to store the data. As long as the database you use is ODBC compatible you can have 

iChart store all sensor data into your database using a standard Windows ODBC connection. 

More information on ODBC databases and connections can be obtained here:  

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/odbc/htm/dasdkodbcoverview.asp 

 

You can access the ODBC menus from Project | 

ODBC. 

If you have not set up an ODBC database before, you 

will be prompted with a dialog box asking if you would 

like to setup a new ODBC connection. Click Yes. 

Open Database simply opens the connection to the 

database for which ODBC has been configured for in 

the Setup ODBC. 

Close Database simply closes the connection to the 

database for which ODBC has been configured for in 

the Setup ODBC. 

 

A few common quirks of an ODBC connection: 

1. When a new device is added, close the ODBC database and then run ODBC setup again 

to create the new table. 

2. When a parameter is added, the parameter column needs to be manually added into the 

database. iChart only issues the “CREATE TABLE” statement and will not issue an “ALTER 

TABLE” statement. 

3. mySQL requires an INI setting change (C:\Program Files\NexSens\iChart6\ichart.ini) 

GenericAutoIncrement should be set to INTEGER AUTO_INCREMENT UNIQUE 

 [ODBC] 

DateTimeFmt=%Y-%m-%d %H:%M:%S 

;GenericAutoIncrement=INTEGER IDENTITY 

GenericAutoIncrement=INTEGER AUTO_INCREMENT UNIQUE 

AccessAutoIncrement=AUTOINCREMENT 

MySQLAutoIncrement=INTEGER AUTO_INCREMENT UNIQUE 

SQL2000AutoIncrement=INTEGER IDENTITY 

RealDataType=REAL 

ForcePrintable=1 

CheckODBCIntervalMin=0 
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Setting Up an Example ODBC Connection to an Access Database 

The most challenging part of using iChart to store data into a custom database is setting up the 

ODBC connection through Microsoft’s ® ODBC wizard. This example shows how to setup an 

ODBC connection to a Microsoft Access database.  

After selecting Setup Database, click Yes to setup a new ODBC connection. 

 

This will open the ODBC Setup wizard. From the Database drop down menu, select Access. 

 

Click New to open the Select Data Source dialog box. Click on the Machine Data Source tab. 

 

Click New and select System Data Source. Click Next. 
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From the list of available database types select Microsoft Access Driver (*.mdb). 

 

Click Next and then Finish. Now the ODBC Microsoft Access Setup dialog box will show up 

on the screen.  

Enter a Data Source Name and Description and then click Create. 
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Enter a Database Name and click OK. Here the location of the database can also be changed. 

 

Microsoft wills ay the database has been successfully created. Click OK. 

 

Click OK to the ODBC Microsoft Access Setup screen. 

 

Click OK to the Select Data Source dialog box. 
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Click Create on the ODBC Setup dialog box. 

 

Existing data can now be posted in iChart by selecting Project | ODBC | Repost Data. 

 

 

4.3 Importing Data 

iChart can import data from CSV files as well as ODBC databases. 

See the interface manuals for each for instructions on importing into your iChart project file: 

 http://www.nexsens.com/pdf/manuals/generic_import-odbc_manual.pdf  

 http://www.nexsens.com/pdf/manuals/generic_import_manual.pdf  
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4.4 WQData.com: Posting Data to the Internet 

Most new environmental monitoring projects now require access to sensor data through an 

Internet datacenter.  Unfortunately, this component is usually difficult to develop due to the lack 

of web-enabled features and capabilities in many of the environmental sensors and dataloggers 

available on the market today.  Before iChart, many organizations had to hire expensive outside 

consulting services to develop a web interface for their systems. 

NexSens iChart software contains an integrated web posting tool – WebDB – that can take data 

stored in an iChart database and automatically upload it to a web server.  Your “Datacenter” is 

accessible online through NexSens’ data hosting service at http://www.WQData.com.  iChart 

users who choose to host data online can access it by logging into WQData.com with their 

username and password.   

New licenses of iChart software include a limited, one-year trial account to host data at 

http://trial.WQData.com.  Posting data to WQData.com is the easiest and fastest way to make 

your data accessible over the Internet.  No web development or outside consulting is required.  

NexSens has already developed the web interface for you and it can be used to display data in 

tables and graphs, and to download data in CSV format for use with popular spreadsheet 

programs.  The only requirements are iChart software and a PC with a real-time connection to 

the Internet. 

Configure WebDB to Upload Data to WQData.com: 

 

iChart can begin posting data to WQData.com as soon as a device has been added to the 

database.  To enable WebDB, select the WebDB command from the File Menu. 

 

In the Username field, enter a 

desired WQData login username. This 

username will be used to log into your 

WQData website. Click Check to make 

sure the desired username is not 

already in use. Type a password in the 

Password and Confirm Password 

fields.   

Fill in the Website Header 

information and then under the 

Contact section, enter in your contact 

information. This information will be 

stored in your WQData database, but 

will not be displayed on the website. 

 

Click OK to create your online datacenter and export your current database to the web server.  

You can access your datacenter online at http://www.WQData.com.  

Note: you cannot click OK or go to any other tabs until all fields are filled in. 
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Setting an Internet Data Posting Schedule: 

 

By default, WebDB will post new data to your online datacenter once every 60 minutes, on the 

top of the hour.  You can change this schedule by selecting the Schedule tab in the WebDB 

Setup dialog box. 

 

To disable auto WebDB posting, uncheck the Enable Auto WebDB Posting box. This box is 

only checked if the account setup is successful. 

You can still manually post to WebDB if this option is turned off. 

Select the days of the week and time interval during which WebDB will post data, or you can set 

up to four specific times when WebDB will post data each day.  Specify an offset (in seconds) if 

you need to wait for sensors to finish warming up before posting data. 

Click OK once your schedule is finished to activate it.  WebDB will begin posting new data to 

your online datacenter on this schedule. 

Changing WQData password: 

Your WQData password can be changed by selecting File | WebDB | Change Password… 

 

Enter your current WQData password along with a new password in the given fields. 
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Troubleshooting WQData.com Connection Problems 

 

From time to time customers experience issues related to connection problems between the 

WQData.com server and iChart running on a PC. 

These issues are usually the result of a client side firewall blocking traffic between the PC and the 

WQData.com server. When a WQData.com account is created three xml files are created on your 

computer. Once created, these files are uploaded via ftp (file transfer protocol) using port 21. 

When the upload is complete, a php script is invoked on the server side by the PC running 

iChart, using http protocol on port 80. All actions and results of that script are performed on and 

to the server side and does not do anything to the PC running iChart.  

These scripts simply use the three xml files to create a WQData.com database, create a table for 

the database to be filled with data, and then deposit data to the table in the database 

All data is transferred to trial.wqdata.com and redirected to the www.nexsensdatacenter.com 

domain. 

Another item to check before creating any WQData.com account or uploading data to your 

WQData.com database is internet connectivity. Open a web browser program such as internet 

explorer and go to www.wqdata.com. If the website loads correctly then your internet 

connection should be working. 

Typically, the problem resides in the fact that IT staff or a personal firewall are blocking ftp 

communication, port 21, or http php scripts, port 80. Check with your IT staff on whether or not 

this will be a problem with your computer. 

If WQData.com has stopped posting data to the web: 

If data is not being posted to WQData.com there are several things to check: 

 

First check if there is data in iChart: 

• Make sure iChart is running on the computer used to retrieve data 

• Make sure the data is in iChart (the main instrument control screen shows the last 

data point retrieved). 

o Historical data can be verified to exist by selecting “Report | New Report” and 

picking parameters from the right hand tool bar. 

 

Second check if iChart can post data: 

• Make sure WQData.com can be displayed on a web browser on the computer and 

you can login with the username and password specified in iChart. 

• If iChart is running and the data is up to date, try manually posting data by 

selecting: 

o “File | Send To | WebDB”. 

o Select “Only data defined below” and specify the From as the last date data is 

on the WQData website. 

o Select “24” as the hours of data at a time.  

o Click OK. 

• If manually posting is unsuccessful iChart may not be able to access WQData.com or 

the username and password may have changed. Check your user settings in “File | 

WebDB | Setup”. 
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4.5 Moving To Another Computer Or Backing Up Data 

In some instances it may become necessary to copy your iChart database to a different 

computer.  This process is extremely simple and is done by selecting the Backup command 

from the File Menu. From time to time you may also want to backup your iChart database to 

another location, other than the computer running iChart, in case of an emergency.   

Database Backup Process 

 

Select a destination folder for your backup database 

in the To field.  This should be a floppy disk, network 

folder, USB drive, or other location.   

Select None to disable the automatic backup 

schedule and choose to backup All data in the 

database.   

Click the Backup Now button to backup your iChart 

database to the specified location.  

 

 

Database Restoration Process 

 

Install iChart software on your new PC.  Once the 

installation is complete, start the program and select 

Restore from the File Menu. 

Enter the location of your backup IDB or ICR file in 

the From field.   

Click the Restore Now button to restore your 

database on the new PC.  The files will be restored to 

iChart’s “Users” folder located in (default): 

 C:\Program Files\NexSens\iChart6\Users\ 

 

 

Your data will now be accessible on the new PC.  Open the database by selecting the Open 

Project command from the File Menu.   
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5 Reference Guide 
5.1 Main Project Window 

This section describes the components and functions contained within the Main Project 

Window in iChart software. 

 

Title Bar 

The Title Bar displays the filename of the open iChart database. 

Menu Bar 

Many of iChart’s core features and functions can be accessed through the Menu Bar.  More 

information on specific program functions in the Menu Bar can be found in Section 6.6 – Menu 

Commands. 
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Main Toolbar 

 

The Main Toolbar contains icons that provide single-click access to core program functions. 

 

New Project - Creates a new iChart database.  iChart will display the Add New Device 

wizard to help you setup the database. 

 

Open Project - Opens an existing iChart database. iChart will display the Open Project 

dialog box, where you can locate and open the desired database. 

 

Save – In Report Mode, saves the current report in HTML format.  In Basemap Mode, 

saves changes to the current basemap. 

 
Print – Prints the current iChart report or basemap. 

 
Navigation Panel - Toggles the Navigation Panel on and off. 

 
Tools - Toggles the right tool bar on and off.  

 
New Basemap – Creates a New Basemap and opens Basemap Mode 

 
Instrument Mode - Opens the instruments tools. 

 
New Report  - Creates a new report and opens the Report Tools 

 

Schedule Tasks - Schedule tasks that will occur automatically like remote 

interrogation and report posting. 

 

To PDF - In Report Mode, saves the current report in PDF format. This button is only 

enabled in Report mode. 
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5.2 Navigation Panel 

The Navigation Panel provides quick access to the three core 

modules within iChart software – Basemap, Instrument Control 

and Report.  The panel is divided into three sections, each 

representing one of these modes. 

Basemap – Lists all basemaps associated with the iChart 

database.  Click an item to open that basemap within iChart. 

Site – Lists all sites, sensors and dataloggers associated with the 

iChart database.    

Report – Lists all open reports associated with the iChart 

database.  Click a file to display that report within iChart. 

Global Sample Interval – Sets a uniform sample interval 

for all devices without internal logging memory in the iChart 

database. 

Auto-Interrogation Status – Pauses and resumes 

auto-interrogation of sensors.  A green icon indicates 

auto-interrogation is active.  A red icon indicates auto-

interrogation is paused.  Click the icon to change its status. 

Interrogate All – Interrogates all devices in the iChart 

database. 

5.3 Instrument Control Screen 

The Instrument Control screen is one of the core 

components of iChart software.  Instrument Control 

provides a direct interface to all devices associated with the 

iChart database.  Through Instrument Control you can set 

auto-interrogation schedules, manually interrogate devices, 

display the current days data, and more. 

This screen shows the most recent measurements retrieved 

from the instrument.  Each parameter is listed and their 

values are displayed in the green indicator boxes.   

Connect: - Connects to given devices and displays live data.  

Live data will not be logged.  Data will only be logged 

according to the log interval.   

Setup – Open the Device Property Dialog box.   

Schedule – Opens scheduling settings for power, 

interrogation and synchronization.   

Interrogate – Manually interrogates the device and retrieves any new data recorded since the 

last interrogation. 
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5.4 Instrument Control Tools 

 

Click the Edit icon  while in the Instrument Control screen to open the Instrument 

Control Tools.  These tools are used to customize the display of data in the Instrument Control 

screen. The options change based on which mode you are in. You can change modes by simply 

clicking on the corresponding tab. 

Text Color – Sets the text color for the most recent data points 

displayed in the Instrument Control’s Device Mode. 

Back Color – Sets the background color for the recent data status 

boxes displayed in the Instrument Control’s Device Mode. 

Alarm Color – Sets the status box background color to be 

displayed when an alarm is triggered for that parameter. 

Parameter Per Column – In some cases a device or datalogger 

may be configured to monitor a large number of parameters.  Use 

this field to display the most recent data points in multiple columns 

in Instrument Control’s Device Mode. 
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5.5  Menu Commands 

5.5.1 File Menu 

New Project – Creates a database. iChart displays a menu to 

help you setup your first database. 

Open Project – Launches an existing database. iChart displays 

the Open dialog box in which you can locate and open the 

desired file. 

Close – Closes the open iChart database and along with all 

associated reports and basemaps. 

Save – In Report Mode, select this command to save the current 

report in HTML format.  In Basemap Mode, select this command 

to save the current basemap. 

Set Project ID – See Section 6.16 for more details.   

WebDB – Setup WebDB or specify WQData basemaps. See 

section 7.4 for  more details.   

Operating Mode – Choose to run iChart in server, client or the 

default stand-alone mode. See Section 7.15. 

Backup – Opens the Backup Data dialog box.  

Restore – Opens the Restore Data dialog box.  

 

 

Import – Imports data from a .CSV file into the open iChart database.  Caution: Once data has 

been imported into the iChart database it is not possible to remove it.  This action also will 

overwrite existing iChart data points that have identical date/time stamps in the .CSV file.  . 

Export – Exports the open iChart database to a .CSV file. 

Send To – In Report Mode, this command sends a report to an e-mail recipient, FTP server, 

folder, or Microsoft Excel. You can also use this command to manually update your Webdb 

database. See Section 7.14.6 for more information. 

Print – In Report Mode, select this command to print the current HTML report. 

Print Preview – In Report Mode, select this command to preview the output of the Print 

command. 

Print Setup – Select this command to configure specific printer settings. 

Recent Databases – A listing of the four most recent iChart databases is displayed near the 

bottom of the File Menu.  Click a database listed here to open it in iChart. 

Exit – Exit iChart software. 
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5.5.2 Edit Menu 

Undo – Select this command to undo the most recent iChart 

action.  

Redo – Select this command to redo the last undo in iChart. 

Cut – Select this command to cut an object and place it on the 

clipboard. 

Copy – Select this command to copy an object and place it on the 

clipboard. 

Paste – Select this command to paste an object from the clipboard 

into iChart. 
 

Preferences – Open the System Setup dialog box. See Section 7.14.3 for more information. 

5.5.3 View Menu 

Main Menu – Select this command to toggle the display of the Main 

Menu. To display the main menu once it has been toggled, hit the ‘esc’ 

key.  

Main Toolbar – Select this command to toggle the display of the Main 

Toolbar. 

Status Bar – Select this command to toggle the display of the Status 

Bar. 

Basemap Tools – Select this command to display the Basemap Tools. 

Report Tools – Select this command to display the Report Tools. 

Instrument Tools – Select this command to display the Instrument 

Control Tools. 

 

Navigation Panel – Select this command to toggle the display of the Navigation Panel. 

Diagnostic Window – Select this command to display iChart’s Diagnostic Window.  The 

diagnostic window is an advanced tool used by NexSens technical support staff for 

troubleshooting purposes. 

Full Screen – Select this command to toggle Full Screen mode in iChart.  Full Screen mode will 

maximize the iChart program window and hide all top line Menu Commands. 

5.5.4 Basemap Menu 

New Basemap – Select this command to create a new basemap for 

the open iChart database.  

Remove Basemap – Select this command to open the Remove 

Basemap dialog box.  Select a basemap from the list and click the 

Remove button to delete the basemap from the iChart database. 
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5.5.5 Project Menu 

Pause Auto-Interrogation – When auto-interrogation is 

enabled, pauses auto-interrogation of devices in the iChart 

database.   

Unpause Auto-Interrogation – When auto-interrogation is 

paused resumes auto-interrogation of devices in the iChart 

database.   

Clear Warning Message – Clears the Auto-Interrogation 

Failed warning message. 

Setup Device Wizard – Open the Device Wizard dialog box.  See 

Section 4 Adding Devices for more information. 

Setup iChart Alarm – Open the iChart Alarm dialog box.  See 

Section 5.7 Setting Up and Using iChart Alarms for more 

information. 

Setup Device – Open the Device Property dialog box.   

Setup Schedule – Open the Setup Device dialog box. See Section 5.5 for more information. 

Interrogate – Interrogates the currently selected device. 

Interrogate All – Interrogates all sensors in the iChart database individually. 

ODBC – You can select to either open an ODBC database or create a new one. See section 6.3 

for more information. 

Add Field Note – Adds a field note to reports made with this database. 

Project Monitor – Opens System Monitor dialog box.  See section 5.8 Monitoring Critical 

Projects for more information.   

Sync all iSIC clock – Sync’s the clock of all iSIC data loggers in the current project. 

Property  - Opens the properties dialog box of selected device.    
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5.5.6 Report Menu 

New Report – Creates a new Report from data stored in the open 

iChart database.  

Open Report – Opens a previously created report associated with the 

current iChart database. 

Create PDF Report – In Report Mode, select this command to export 

the current report in PDF format.  This will generate a new PDF 

document that can be saved on your PC. 

Page Properties – Select this command to modify the settings of the 

PDF generator. 

Refresh Report – Refreshes the current report view. 

Other Setup – Opens Other Setup dialog box.   

Unit Tab – Used to change the units of each parameter available.   

Misc Tab – Contains addition settings to adjust.  Data display order, 

time limit mode and auto-report index options can be set here.   
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5.5.7 Advanced Menu 

Lock – Select this option to “lock” the iChart database and 

prevent unauthorized users from making changes to settings and 

devices. 

Set Password – Select this command to enable and set an 

administrator password for the open iChart database.  Users will 

be required to enter this password before any changes may be 

made to the database’s settings and configuration. 

System Check – Checks the status of all devices in the iChart 

database. 

iSIC – Select this command to access a sub-menu that contains 

special configuration and troubleshooting tools for NexSens iSIC 

dataloggers and telemetry systems. 

 

Sensor Interface – Select this command to access a sub-menu that contains special 

configuration and troubleshooting tools for various environmental sensors. 

Global Sample Interval – Select this command to set a global sample interval.  This action will 

set a uniform sample interval for all devices in the iChart database. 

Terminal – Opens an RS232 terminal to the currently selected device in Instrument Control 

Mode.  

5.5.8 Window Menu 

Cascade – Arranges all iChart windows (ie. Instrument Control, Report, 

Basemap) in a cascading pattern. 

Tile Horizontal – Arranges all iChart windows horizontally. 

Tile Vertical – Arranges all iChart windows vertically 

Open Windows… - All open iChart windows are listed in the Window menu.  

Select an open window to switch between reports, basemaps, and instruments. 

5.5.9 Help Menu 

User’s Guide – Opens the iChart User’s Manual in PDF format. 

About iChart – Displays the About iChart dialog box.   

Check For Updates – Select this command to check for iChart 

software updates available at NexSens’ website. 

Register iChart – iChart can be used for 30 days on a free trial basis.  

During these 30 days all features are available.  Once the 30-day trial 

period is completed, your copy of iChart must be registered with 

NexSens.  Contact NexSens to register iChart today. 

 

NexSens Website – Select this command to open your web browser to go directly to NexSens 

website: http://www.NexSens.com 
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5.6 Advanced Dialog Boxes and Menus 

5.6.1 System Setup 

 

Located in Edit | Preferences.   

General Tab 

 

Program Start 

Enable startup dialog – Enables the Open Choice Dialog window to open upon iChart6 startup. 

This item is checked by default. From the Open Choice Dialog window you can select how you 

want iChart6 to open every time it opens.   

Auto load project – This option is only available if the Enable open choice dialog box is 

unchecked. iChart will open the last project used upon iChart6 startup. 

Auto load basemap – This option is only available if the Enable open choice dialog box is 

unchecked. iChart will open the last project used and open to the basemap view upon iChart6 

startup. 

Auto load report – This option is only available if the Enable open choice dialog box is 

unchecked. iChart will open the last project used and open to the last report made upon iChart6 

startup. 

Display 

Time format – The format selected here will change the format everywhere it is seen in 

Instrument Control screen. This format will not, however, affect the way time is seen in 

reports. Select H:M to display hours:minutes, and selected H:M:S to display 

hours:minutes:seconds. 

Enable basemap rotation – Enables the Basemap view and Instrument Control view to be 

rotated. Each view will be displayed on the screen for the number of seconds specified. This 

option is ideal for displays in lobbies and other areas where you would like the viewers to be able 

to see different iChart screens. 
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Enable flash warning – Enables the Auto Interrogation Failed warning window to display 

whenever an auto interrogation fails. This box is checked by default. You can disable auto 

interrogations from the Setup menu in the main Instrument Control screen. 

Email Tab 

MAPI – Sets iChart to use 

MAPI email protocol when 

ever it needs to use email, for 

example when iChart 

automatically sends reports 

via email. The email options 

will need to be setup in their 

respective menus. Contact 

your system administrator or 

email service provider for 

information regarding which 

protocol you should be using. 

SMTP – Sets iChart to use 

SMTP email protocol when 

ever it needs to use email, for 

example when iChart 

automatically sends reports via email. The email options will need to be setup in their respective 

menus. Contact your system administrator or email service provider for information regarding 

which protocol you should be using. 

Advanced Tab 

 

COM Port Access 

Enable remote access – allows you to interface to iChart remotely via COM port.  

Enable pass through – allows you to interface to iChart using pass through mode via COM port. 

Data Replication 
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Enable – Enabling Data Replication allows you to save data in csv (Microsoft Excel) format. 

iChart will always save data in an iChart database files located in C:/Program 

Files/Nexsens/iChart5/Users/<iChart database file name>.Data.  

Include header – when using saving in another specified format, iChart can save the header 

information of that data into the new format. 

Format – This option allows you to select the format that you wish to save your data in. 

Folder – This option allows you to specify the folder which you would like the data to be saved in.  

Interrogation 

Broadcast iSIC close cmd – This option is for backwards compatibility. Use only when instructed 

to by Nexsens Technology Support Engineers. 

Enable Group iinterrogation – In order for group interrogation to work, this box must be 

checked. This is not checked by default, nor is it ever automatically checked by iChart.  

 

GUI Tab 

 

Enable Advanced Interface – This checkbox allows the user to enable or disable advanced 

interface.   

Readout per column – This option affects the number of devices shown in the main Instrument 

Control screen per column. The value in this box does not directly correlate to the actual 

number of devices shown, as iChart automatically evens each column out so that they align 

evenly. 

Application Skin – This option allows you to select the type of windows theme you would like 

iChart to display. Note: some themes may not look like that them if certain options in the 

windows operating system are not setup.  
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Retry Notification – Number of times iChart will retry communicating to a device before it will 

change the basemap read-outs and instrument screen time to red to signify the failed 

connection. 

     

Log Diagnostic Data – This checkbox allows the user to enable or disable logging diagnostic data.   

Minimize to System Tray – When checked, iChart6 will be displayed only in the system tray when 

minimized.   

5.6.2 Page Property 

Page Property allows you to setup features such as the paper size and other paper options. 

These features do not become displayed in iChart and will only affect printing options. You will 

need to have a report open to change the page property. These changes only affect the report 

that is open. If you would like to modify more than one report, you will have to do this 

individually.  This located in Report | Page Property.   

 

General Tab 

Margin 

When in html view, iChart will set the margins to the inches specified. This is just like margins 

set in Microsoft Word, etc. Margins should be chosen based on what looks the best on your 

printer. 

Page Break 

When in html view, iChart will automatically insert page breaks after certain events as specified. 

This is just like the page break in Microsoft Word, etc. Using page breaks allows you to keep 

sections of the report on individual pages, and generally makes the report look better. All page 

break options are enabled by default. 
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PDF Tab 

 

Page 

Size – Select the paper size you would like for PDF reports. This should be the actual size of 

paper you will be using to print the PDF report. 

Width / Height – If Custom is selected from the Size drop down menu, you will be able to enter 

in the actual Width and Height of the paper you will be using to print your PDF report. 

Page Orientation – Select the orientation you would like the pages of your PDF report to be 

printed. 

Font 

Scale – Allows you to scale up or scale down the font size of your PDF report by the percentage 

entered. 

Y-Axis Scale Orientation 

Sets the orientation of the Y-Axis scale labels on graphs generated in your PDF report. 
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5.6.3 Field Note 

 

The field note field is located in every report generated 

by the current database, as long as you have checked 

Summary to be displayed. This feature cannot be 

used when a report is open.  This is located in Project 

| Add Field Note… 

 

Time – The time to be displayed for the note. 

Type – The type of note to be displayed. There are many pre-made notes to insert. Or you can 

create your own by selecting Custom. 

Note – The text to be displayed for the note. 

 

5.6.4 Manually Sending Automatic Data 

The ‘File | Send To’ feature allows you to send iChart data to other programs or other locations. 

WebDB 

 

Selecting File | Send To | WebDB allows you to manually post data to your WQData.com 

website.  

All data from last auto-post – will manually post data from the last time iChart posted data. 

Only data defined below – will manually post data from the data specified in the From field to 

the date specified in the To field.  A selection from the Device drop down menu must be chosen 

to pick which devices to post data from.  Also, a number of hours of data to be posted can be 

chosen in the Post text box.  Click OK when finished. 
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5.7  National Data Buoy Center 

NexSens developed an automatic generated report format that allows iChart data to be sent 

directly to the National Oceanic and Atmospheric Administration (NOAA) National Data Buoy 

Center (NDBC), a part of the National Weather Service (NWS). 

 

Contact NexSens on how your system can be included. 

Data is automatically sent via File Transfer Protocol (FTP) in the required NDBC format to NOAA. 

More information regarding the NDBC can be found here: 

http://www.ndbc.noaa.gov/  

From the NDBC website: 

“NWS forecasters need frequent, high-quality marine observations to examine 

conditions for forecast preparation and to verify their forecasts after they are 

produced. Other users rely on the observations and forecasts for commercial and 

recreational activities. NDBC provides hourly observations from a network of about 

90 buoys and 60 Coastal Marine Automated Network (C-MAN) stations to help meet 

these needs. All stations measure wind speed, direction, and gust; barometric 

pressure; and air temperature. In addition, all buoy stations, and some C-MAN 

stations, measure sea surface temperature and wave height and period. Conductivity 
and water current are measured at selected stations.” 
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5.8  Using iChart in Server / Client Mode 

iChart Server / Client mode allows a single copy of iChart software to retrieve data from devices 

and then transfer the data over Ethernet to other computers running in Client mode. The server 

mode software handles all the device communication. It also stores the data and information on 

the data logging network. Client computers can then access data from the Server computer over 

Ethernet, such as a LAN, WAN or the internet. 

This functionality is ideal where multiple computers need real time access to the same data, 

without burdening the devices with simultaneous communication demands.  

By default, all iChart databases run in Standalone mode. 

 

You can easily change between modes by selecting the desired mode from File | Operating 

Mode. 

Getting Started: 

Running iChart Server/Client mode is a simple three step process: 

 

1. Install iChart and setup and iChart configuration (see Adding Device to an iChart 

Database section of the manual for more information. For specific sensor setups see 

http://www.nexsens.com/support/manuals.htm 

 

2. Set the iChart configuration to run in Server mode (see the Using iChart in Server 

/ Client Mode section in the iChart manual) 

 

3. Go to other computers, install iChart and copy the iChart configuration (Using File | 

Backup\File |Restore) from the server computer and set it to run in Client mode. 

 

Note: Each installation will need to be registered at: http://www.nexsens.com/register.php  
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Setting up the Server Mode computer: 

To begin running iChart in Server mode, simply select Server from the Operating Mode list. 

This computer must be connected to a local network or internet. Once one computer is running 

in Server mode, other computers can properly run in Client mode. On another computer that is 

connected to the same network select Client from the Operating Mode list. A dialog box will 

appear asking for the server address. Enter the host name or IP address of the computer 

running in Server mode.  

 

One thing to be aware of is that by 

default iChart uses Port 22703 for 

Client/Server mode. If the server is 

running a firewall port 22703 must 

be allowed to be accessed. 

For example, if your computer is 

using the Windows Firewall, you can 

add the iChart Server port by going 

to Start | Control Panel | 

Windows Firewall in Windows. 

Then click on the Exceptions tab 

and click the Add Port button. Then 

add TCP port 22703 to the list. 

For added security you can click the 

Change Scope button and add only 

the IP addresses of the computers 

that will be running in Client mode. 

 

Setting the sampling interval: 

 

After the database has been created and setup to run in Server mode, click on the clock icon at 

the bottom left corner of the Navigation Panel.  

 

In the Sample Interval field, enter the interval in seconds that you want to get a reading from 

the sensors. This reading will be updated on basemap readings and the main instrument display 

window.  
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In the Log Interval field, enter the interval in seconds that you want to log a reading into your 

iChart database. 

Note: When using the Global Sample/Log Interval make sure to turn off auto interrogation. 

You can do this by clicking the Setup button on the main instrument control screen and then 

unchecking the Enable check box.  
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Setting up the Client Mode computers: 

Make sure that the client computers are using the same .ICR file that the server computer is 

using. You can easily ensure this by using the iChart Backup/Restore feature (see section 7.7 

Backup and Restore). Simply create an iChart database on the computer that will be running in 

Server mode. Then go ‘File | Backup’ in iChart, and backup the database to a network location, 

or thumb drive, CD, etc. Next go to the computer that will be running in Client mode and go 

‘File | Restore’ and specify the backed up database. 

Next go ‘File | Operating Mode’ and select client from list. Enter the IP address of the computer 

running iChart Server. 

 

Click OK and computer will now run in client mode.  

You should now set a sample and log interval. Click on the clock icon again at the left corner of 

the Navigation Panel. 

In the Sample Interval field, enter the interval in seconds that you want to get a reading from 

the server. This reading will be updated on basemap readings and the main instrument display 

window. 

In the Log Interval field, enter the interval in seconds that you want to log a reading from the 

server. This reading will be saved into an iChart database as if the sensors were connected to the 

client computer. 

Now that your database is running and getting readings, you can now utilize some of the 

features of iChart that will make an easy to view screen. For example client window, you could 

create a basemap, and then disable all of the menu systems to have a screen like this: 

 

See the basemap section of this manual for more information on setting up basemap displays. 
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5.9  Protecting an iChart Project 

When using remote telemetry options such as cellular and phone line, any computer running the 

same project file can access the data loggers and sensors in that project file. However, the 

project file may need to be shared among other people on other computers so that they can 

generate iChart reports, and view project data through iChart. In this case it is best if the project 

file is locked so that only the computer that created the project can interrogate devices, send 

system alerts, post data online, edit sensor configurations and data logger settings. To do this; 

simply select File | Set Project ID 

 

iChart will ask you if want to set the project ID of this iChart. 

 

iChart will then output the project ID of your computer. Write 

this ID down. In the case that the project file would later need to 

become unprotected so that other computers can interrogate 

devices, edits sensor configurations, etc, the project ID will be 

required. 

 

The next time File | Set Project ID is selected, iChart will ask 

for the current project ID. The project ID can be cleared 

(unprotecting the project file) by entering the project ID and 

putting a check in Clear Project ID. 

 

Features Protected: 

Add device 

Edit device 

Enable/disable device 

Remove device 

Calibrate 

Setup site 

Post wqdata 

Setup wqdata 

Interrogate device 

Execute SQL file 

Repost ODBC data 

Setup ODBC 

Open ODBC 

Add field note 

Setup parameter 

Sync iSIC clock 

New basemap 

Create/edit wqdata area 

map 

Create/edit wqdata site 

map 

Remove wqdata area map 

Remove wqdata site map 

System monitor 

Setup autosync iSIC clock 

Interrogate all 

Global sample interval 

 

 


